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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1 ¡Bienvenido a GUITAR RIG SESSION!
GUITAR RIG SESSION es la respuesta profesional de grabación para guitarristas, bajistas 
y compositores. Consiste en dos productos: la compacta interfaz de audio GUITAR RIG 
SESSION I/O y la versión ESSENTIAL del programa GUITAR RIG 4, ampliamente aclamado 
por la crítica especializada.

El GUITAR RIG SESSION I/O es una interfaz de audio de gran calidad diseñada y optimiza-
da para su con GUITAR RIG 4. Constituye una tarjeta de audio profesional, provista de un 
preamplificador de micrófono con alimentación fantasma y dos entradas para la conexión de 
guitarras y bajos eléctricos así como dispositivos de línea. Una salida de línea de dos canales 
permite la conexión del aparato a su sistema de altavoces y un enchufe estéreo permite la 
conexión de los auriculares con manejo de volumen independiente.

Su robusta y compacta carcasa de metal fue diseñada para soportar todo tipo de situaciones, 
desde el trabajo rutinario en el estudio hasta las exigentes condiciones de las actuaciones 
en vivo.

En los capítulos siguientes describiremos las distintas características del GUITAR RIG SESSION 
I/O y a sacar el máximo provecho de las mismas. Por favor, lea esta manual cuidadosamente 
para poder familiarizarse con el producto.
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2 Antes de empezar: Observaciones importantes
Antes que nada, lea primero este capítulo cuidadosamente antes de emplear su GUITAR RIG 
SESSION.

2.1 Números de serie y chapa identificadora

GUITAR RIG SESSION tiene dos números de serie. En la parte inferior del producto encon-
trará el número de serie del GUITAR RIG SESSION y la chapa identificadora con el nombre 
del modelo y otras especificaciones técnicas. El número de serie necesario para la activación 
del programa GUITAR RIG 4 está situado en funda del CD del producto.

2.2 Usar la unidad de manera segura

Lea estas instrucciones atentamente para evitar daños a su salud o al producto.

2.2.1 Advertencia
Para prevenir lesiones auditivas, observe las siguientes recomendaciones de seguridad:

 • Este producto combinado con un amplificador, auriculares o altavoces puede generar so-
nidos de volumen muy alto perjudiciales para el oído.

 • Para su protección, baje todos los niveles de volumen antes de empezar a usar GUITAR 
RIG SESSION I/O . Al tocar la música, eleve gradualmente los respectivos controles de vo-
lumen para establecer el nivel deseado.

 • No lo utilice durante tiempos prolongados a volúmenes elevados. Si experimenta problemas 
auditivos o zumbidos en los oídos, consulte inmediatamente al médico.
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2.2.2 Precauciones
Para asegurar que GUITAR RIG SESSION I/O o cualquier otro dispositivo conectado al mismo 
no resulte dañado durante su uso o mantenimiento, es importante que siga las siguientes 
instrucciones:

 • No abra el dispositivo ni intente desarmarlo o modificar su interior. El dispositivo tiene com-
ponentes que no pueden ser reparados por el usuario. Si el aparato no funcionara correc-
tamente, suspenda inmediatamente su uso y hágalo revisar por personal calificado.

 • No exponga el aparato a la lluvia y no lo utilice cerca del agua o en condiciones de hume-
dad.

 • Evite la penetración de cualquier objeto o líquido en la unidad.

 • Nunca use o guarde la unidad en lugares sujetos a temperaturas extremas (p. ej., bajo la 
luz directa del sol en un automóvil o cerca de la calefacción) o a altos niveles de vibración. 

 • No coloque el GUITAR RIG SESSION I/O en una posición inestable en la que pueda caer 
al piso accidentalmente. Antes de mover la unidad, desenchufe los cables conectados.

 • Antes de encender o apagar algún componente, ponga a mínimo el volumen del mismo. 

 • No emplee excesiva fuerza al usar los botones, perillas, interruptores o conectores.

 • Para la limpieza de GUITAR RIG SESSION I/O, utilice un paño suave y seco. No emplee 
solventes, líquidos limpiadores o paños con químicos limpiadores.

2.2.3 Deposición del producto
Si por alguna causa el producto se estropeara sin posibilidad de arreglo o si llegara al término 
de su vida útil, cumpla con las regulaciones de su país relativas a la deposición de residuos 
electrónicos.
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2.3 Descargo de responsabilidad

Native Instruments GmbH no puede ser responsabilizada por daño, pérdida o destrucción de 
datos causados por uso indebido o modificaciones realizadas a GUITAR RIG SESSION I/O.

La información contenida en este manual es la correcta al momento de su impresión o apari-
ción digital. Sin embargo, Native Instruments se reserva el derecho de realizar modificaciones 
a las especificaciones existentes, en cualquier momento, y sin previo aviso ni obligación de 
actualizar las unidades existentes.
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3 El hardware del SESSION I/O
Este capítulo le brindará un panorama general de la mecánica del SESSION I/O.

3.1 Panel frontal

1 La entrada de micrófono(Mic) presenta enchufes XLR (balanceados). Sirven para conec-
tar el micrófono al preamplificador de la unidad para la entrada 1. Habilite por favor la 
alimentación fantasma para los micrófonos de condensador.

2 El enchufe de Input 1 (conector de ¼”, TRS balanceado) acepta la entrada de señales 
de línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. 
Conecte aquí su guitarra, bajo o teclado, o el canal izquierdo de un dispositivo estéreo.

3 El enchufe de Input 2 (conector de ¼”, TRS balanceado) acepta la entrada de señales 
de línea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst. 
Conecte aquí una guitarra, bajo o teclado, o el canal derecho de un dispositivo estéreo.

! 
Tenga en cuenta que esta entrada tiene prioridad por sobre la entrada XLR (1). Por lo que 
cuando está en uso, la entrada XLR quedará automáticamente deshabilitada.
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4 Esta perilla controla la ganancia de la entrada (Input) 1.

5 Esta perilla controla la ganancia de la entrada (Input) 2.

6 El interruptor Inst/Line establece la sensibilidad de entrada para las entradas 1 y 2. 
Cuando no está presionado, las entradas aceptan señales provenientes de instrumentos 
como guitarras o bajos; cuando está presionado, aceptan señales de línea. El tipo de 
entrada seleccionado se indica en la parte de arriba de la unidad.

7 Esta perilla ajusta el volumen de salida (Output 1/2).

8 Enchufe de auriculares para la conexión de sus auriculares estéreo.

9 Esta perilla ajusta el volumen de salida de los auriculares.

3.2 Panel superior

1 Este campo muestra el tipo de señal seleccionado (micrófono, instrumento o línea) de 
la entrada 1.

2 Este LED indica la presencia de señal en la entrada 1/2.
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3 Este LED indica la presencia de distorsión en la entrada 1/2 (por lo tanto, no debería 
encenderse al estar tocando música).

4 Este campo muestra el tipo de señal seleccionado (micrófono, instrumento, línea) de la 
entrada 2.

5 Este LED indica si la alimentación fantasma ha sido activada.

3.3 Panel posterior

1 Estos enchufes transmiten la señal recibida al ordenador. Las salidas TRS funcionan con 
conectores balanceados y no balanceados. Asegúrese de utilizar ambas salidas si desea 
lograr sonido estéreo.

2 Esta ranura acepta candados de seguridad Kensington™ y compatibles. Úsela para ase-
gurar su unidad contra robos.

3 El puerto USB conecta la unidad con el ordenador. Su ordenador tiene que aceptar USB 
2.0 para poder trabajar con GUITAR RIG SESSION I/O . La unidad también se alimenta 
de la energía eléctrica transmitida a través del puerto USB. Conecte la unidad directa-
mente en un puerto USB 2.0 del ordenador y evite el empleo de concentradores (hubs) 
sin fuente de alimentación propia.
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4 El interruptor de alimentación fantasma de 48 V suministra la energía eléctrica a la en-
trada (1) XLR de micrófono. Los micrófonos de condensador funcionan con alimentación 
fantasma mientras que los otros tipos de micrófonos no. Para evitar serios daños, ase-
gúrese de que la alimentación fantasma esté apagada al conectar micrófonos dinámicos 
o de cinta.
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4 Instalación en Windows XP / Windows Vista
Este capítulo describe la instalación del SESSION I/O en Windows XP y en Windows Vista.

Para más información sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
ción. El mismo se encuentra en el CD del producto o en el menú de GUITAR RIG 4 bajo la 
opción Help > Open Manual > Your Language.

4.1 Instalación del programa 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía 
el GUITAR RIG SESSION I/O .

1. Revise el contenido del CD para ubicar el archivo de instalación. El mismo se llama “Guitar 
Rig 4 Setup”. Si está empleando una versión descargada de GUITAR RIG 4, deberá pri-
mero extraer el archivo de instalación.

2. Haga doble clic sobre el archivo denominado “Guitar Rig 4 Setup” para iniciar el proceso 
de instalación.
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3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación.

4. Se le pedirá determinar la ruta a la carpeta del plugin de su EAD (estación de audio 
digital; p.ej., su programa secuenciador). Si desea usar GUITAR RIG 4 exclusivamente 
en el modo standalone (independiente) o si no sabe bien lo que es un plugin, utilice 
simplemente la opción estándar.

5. Se le preguntará si desea instalar los controladores para las interfaces de audio de GUITAR 
RIG. Seleccione “SESSION I/O” y haga clic en “Continue”.

6. Durante la instalación, Windows mostrará varios mensajes de seguridad, p. ej.: “El contro-
lador no ha pasado el logotipo de Windows” o “Windows no puede verificar el proveedor 
de este controlador de programa”. No se preocupe, todo está bien. Simplemente, haga 
clic en “Continuar de todos modos” (Windows XP) o en “Instalar de todos modos el soft-
ware de controlador” (Windows Vista) y prosiga con la instalación.
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7. Completada la instalación, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:

 • GUITAR RIG 4 – la aplicación standalone con todas sus características.

 • GUITAR RIG 4 plugins: una versión plugin de GUITAR RIG 4 que podrá integrar a su esta-
ción de audio digital (EAD). En ordenadores con Windows, GUITAR RIG 4 acepta los for-
matos de plugin VST y RTAS® .

 • Native Instruments Service Center: esta aplicación se encarga de la activación del produc-
to y gestiona las actualizaciones del mismo. Consulte la guía “Setup Guide” para más infor-
mación.

 • Los controladores de la interfaz de audio GUITAR RIG SESSION I/O.

% Si es propietario por primera vez de un producto NATIVE INSTRUMENTS, deberá re-
gistrarse siguiendo las instrucciones ofrecidas en pantalla. Para más información sobre 

como crear una Cuenta de Usuario NI y sobre la activación de GUITAR RIG 4, consulte la Guía de 
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inicio rápido del Centro de Servicio y el manual ubicados en la carpeta de instalación del Centro 
de Servicio.

Si solamente desea instalar los controladores del aparato, en el CD de instalación hallará por 
separado el correspondiente archivo de instalación del controlador. También podrá descargar 
la última versión del mismo en la sección de asistencia (Support) del sitio de Internet de 
Native Instruments.

4.2 Instalación del aparato

Utilice el cable USB suministrado para conectar el SESSION I/O directamente en un puerto 
USB 2.0 del ordenador.

El SESSION I/O se alimenta a través de la conexión USB. Su operación sólo puede garanti-
zarse si se lo emplea como dispositivo único de un controlador USB 2.0 o con un hub USB 
2.0 con fuente de alimentación propia. En Windows XP, el SESSION I/O solamente funciona 
a partir de la versión Service Pack 2; podrá averiguar la versión de su sistema operativo en 
la ventana de propiedades del sistema.
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Tras la correcta instalación del controlador, el SESSION I/O será reconocido automáticamente. 
Si esto no llegara a ocurrir, inicie nuevamente la instalación del programa de la manera ya 
descrita.

Ahora, los módulos del controlador serán asignados al SESSION I/O y cada uno de ellos abrirá 
una ventana para preguntarle de que manera desea instalar el nuevo dispositivo.

1. Seleccione “no conectar con el sitio web Windows Update”.

2. Seleccione “Instalar el programa automáticamente” (Windows XP) o “Localizar e instalar 
el controlador del programa” (Windows Vista).
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3. Siga las instrucciones de pantalla hasta completar el procedimiento.

4. Los avisos de seguridad de Windows comenzarán a aparecer. Haga clic en la opción 
“Continuar de todos modos” (Windows XP) o “Instalar el software de controlador (Windows 
Vista) para que los controladores se instalen correctamente.

En un ordenador con Windows, el controlador está asociado a un puerto USB en particular. 
Si enchufa el cable USB en un puerto diferente del puerto de instalación original, el proceso 
de asignación del controlador podría comenzar nuevamente: si esto sucediera, simplemente 
siga los pasos explicados más arriba..

Si en algún momento, el ordenador parece no reconocer el SESSION I/O, desconecte el ca-
ble USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el 
ordenador teniendo la interfaz conectada.
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4.3 Configuración

Este capítulo describe el empleo de la interfaz de audio SESSION I/O en Windows XP/Windows 
Vista, atendiendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a suponer que 
usted ya ha activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte la guía 
“Setup Guide” para más información).

4.3.1 Configurar GUITAR RIG 4
Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL. 
Primero, inicie el programa.

1. Cuando el programa arranque por primera vez, la ventana de configuración de audio 
“Audio Setup” aparecerá automáticamente para que pueda llevar a cabo las configura-
ciones correspondientes. Para abrir esta ventana en un momento posterior, en la barra 
de menú del programa seleccione File > Audio and MIDI Settings.

 

2. Abra la ficha „Audio“ y en „Driver“ seleccione ASIO como la interfaz del controlador.

3. Seleccione SESSION I/O en el menú de dispositivos (“Device”).
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Si SESSION I/O no aparece en la lista, entonces algo salió mal. Vuelva a efectuar la instala-
ción de la manera ya descrita.

Podrá acceder al panel de control del controlador al cliquear sobre el botón “ASIO Config”. 
El panel de control del controlador presenta abajo dos campos de lectura de estado que le 
indicarán si el SESSION I/O está conectado y listo para ser utilizado.

 

La interfaz de audio permite la configuración de los siguientes parámetros:

 • Presets: se incluyen varios presetes destinados a los usos más frecuentes; desde presetes 
con latencia mínima para sistemas rápidos con mucha capacidad de procesamiento hasta 
presetes con latencias más altas, para sistemas más lentos. Si usted ya tiene experiencia 
en la configuración de controladores de audio y desea crear su propio juego de configura-
ciones, seleccione entonces la opción “User Defined Settings” (ver abajo). 

 • USB Buffersize y Audio Buffersize: estos parámetros aparecen de color gris si la opción 
User Defined Settings no fue seleccionada en el el menú de Presets. Juntos, estos pará-
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metros definen el sistema de latencia, es decir, el tiempo que pasa desde el momento en 
que la señal de audio se envía al hardware de SESSION I/O y el momento en que dicha 
señal es oída a través de los auriculares o altavoces. Tenga en cuenta que el valor de Audio 
Buffersize deberá ser por lo menos dos veces mayor que el valor de USB Buffersize. El 
tamaño del búfer del USB (USB Buffersize) incide directamente en el uso de CPU por par-
te del sistema. El consumo resultante de CPU difiere mucho de un ordenador a otro, por lo 
que es una buena idea ir probando distintas configuraciones.

 • Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa 
de música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de mues-
treo está puesta en 44100 Hz (calidad de CD). Frecuencias más altas pueden mejorar la 
calidad del sonido pero exigirán, a su vez, una capacidad de procesamiento mayor.

Recomendamos que pruebe primero los tres presetes de latencia que aparecen en primer 
término y luego continuar con los restantes pasos de la instalación. Cuando haya terminado, 
en algún momento posterior debería revisar nuevamente la ficha Audio and MIDI Settings y 
determinar cuál es la mejor latencia para su sistema. Si experimenta fallas en el audio con 
el preset minimal latency, pruebe las configuraciones low latency o standard latency. Valores 
de latencia más altos reducirán la probabilidad de sufrir problemas con el audio.

4.3.2 Emplear el SESSION I/O como la interfaz de audio predeterminada
Si desea usar el SESSION I/O para reproducir todas las aplicaciones de audio de su ordena-
dor (y no sólo el software de música), deberá configurarlo para que sea la interfaz de audio 
predeterminada del sistema.

En Windows XP haga lo siguiente:

1. Abra Inicio > Panel de control > Sonidos y dispositivos de audio.

2. Seleccione la ficha “Audio”.

3. En “Reproducción de sonido” y en “Grabación de sonido”, haga clic en el menú de dis-
positivos predeterminados y seleccione SESSION I/O. 

4. Haga clic en Aceptar para cerrar el diálogo de “Sonidos y dispositivos de audio”.
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En Windows Vista haga lo siguiente:

1. Abra Inicio > Panel de control > Hardware y sonido > Sonido.

2. Seleccione la ficha “Reproducción”.

3. En la lista de dispositivos, seleccione SESSION I/O y luego haga clic en “Predeterminar”.

4. Seleccione la ficha “Grabar”.

5. En la lista de dispositivos, seleccione SESSION I/O y luego haga clic en “Predeterminar”.

6. Haga clic en Aceptar para finalizar.



GUITAR RIG SESSION – 24

4.4 Conexiones de audio y niveles

En los capítulos siguientes aprenderá la manera de conectar el SESSION I/O a su guitarra y 
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato 
como en el programa.

Antes de continuar, inicie GUITAR RIG 4.

4.4.1 Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.

2. Asegúrese de que el selector de entradas esté puesto en “Instrument” (el botón no está 
oprimido), salvo si quiere emplear un preamplificador para reforzar la señal hasta el nivel 
de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del SESSION I/O.

4. Baje el volumen del canal de entrada que no está usando.

Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los 
sintetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener 
sonido estereofónico.
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Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal 
que sea lo suficientemente potente; por lo que debería ajustar cuidadosamente el volumen 
de entrada del SESSION I/O.

Los LED de entrada (INPUT) señalan el volumen de la señal entrante en cada canal:

LED de estado Significado

LED apagado La señal no está presente.

LED verde Se está registrando el ingreso de la señal.

LED rojo El volumen de la señal entrante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque 
algunos acordes al volumen al que acostumbra tocar y eche un vistazo al LED del canal em-
pleado:

1. Mientras está tocando, suba la correspondiente perilla de volumen justo hasta que el LED 
de la distorsión empiece a encenderse.

2. Ahora, baje despacio la perilla hasta que el LED de la distorsión no se encienda más, 
aun al tocar acordes muy fuertes.

Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el SESSION I/O puede 
proporcionar un rango dinámico muy alto sin caer en distorsión.

4.4.2 Conectar un segundo instrumento
Es posible conectar un instrumento en cada canal siempre que los mismos suministren el 
mismo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en 
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo 
canal para lograr así un sonido estereofónico.
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4.4.3 El volumen de entrada de GUITAR RIG 4
Vamos a dar por sentado que su guitarra ya está conectada al SESSION I/O y que su nivel de 
entrada fue correctamente ajustado (véase el apartado 4.4.1). Ahora debemos asegurarnos 
de que la señal de entrada sea procesada por el programa a un nivel adecuado.

Eche un vistazo a la cabecera de GUITAR RIG 4: está compuesta por un módulo de entrada 
con selectores de canal (l/r), un supresor de ruido (Gate) sencillo, un módulo de salida con 
un limitador y, finalmente, la información del consumo de CPU.

% 
Para una descripción y explicación detallada del circuito de reducción de ruidos, consulte el 
manual de dicha aplicación.

Tenga en cuenta que el Medidor de entrada mostrará la amplitud al tocar el instrumento. 
También hallará un deslizante de volumen que controla el nivel de entrada del software. 
Ajuste este control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo 
podrá comprobar con el Medidor de volumen, que se acercará hasta la zona roja sin llegar 
realmente a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibirá una señal mono. Usted 
puede también configurar el módulo de entrada para que direccione la señal de su guitarra a 
través de ambos canales. Por defecto, GUITAR RIG 4 está configurado para procesar ambos 
canales de entrada (l + r están activados), por lo que uno de los canales permanecerá, enton-
ces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el botón 
correspondiente (l o r) a la izquierda del medidor de entrada para desactivar dicho canal y 
que solamente quede activo el canal de entrada en uso. Con esto dirigirá la señal monoaural 
hacia ambos canales.

4.4.4 Conectar la salida
El SESSION I/O proporciona dos salidas mono (L/R) que le servirán para la conexión de su 
sistema de monitorización, sea éste una mesa de mezclas, un par de altavoces activos o el sis-
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tema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, deberá conectar 
los dos altavoces. Un salida estéreo separada (TRS) permite la conexión de sus auriculares.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, ponga el 
volumen en su nivel habitual y baje la perilla de volumen de salida.

2. Si está usando auriculares, conéctelos en el enchufe de salida y tenga la precaución de 
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic. Empiece a tocar y vaya 
subiendo cuidadosamente el volumen de salida o de auriculares del SESSION I/O hasta 
alcanzar el nivel deseado.

% Si su instrumento emplea solamente un canal, ponga la perilla de ganancia del otro canal en 
cero.

Ahora todo está listo, ¡ya puede empezar a tocar!



GUITAR RIG SESSION – 28

5 Instalación en Mac OS X
Este capítulo describe la instalación básica del SESSION I/O en MAC OS X.

Para más información sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
ción. El mismo se encuentra en el CD del producto o en el menú de GUITAR RIG 4 bajo la 
opción Help > Open Manual > Your Language.

5.1 Instalación del programa 

Asegúrese de haber iniciado la sesión con privilegios de administrador. No conecte todavía 
el SESSION I/O .

1. Revise el contenido del CD y ubique el archivo “Guitar Rig 4 Installer”. Si está empleando 
una versión descargada de GUITAR RIG 4, deberá primero extraer el archivo de instala-
ción.

2. Haga doble clic sobre el archivo de instalación para iniciar el proceso de instalación.
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3. Siga las instrucciones en pantalla que lo guiarán a través del proceso de instalación.

4. Se le preguntará si desea instalar los controladores para las interfaces de audio de GUITAR 
RIG. Seleccione “SESSION I/O” y haga clic en “Continue”.

5. Completada la instalación, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:

 • GUITAR RIG 4 – la aplicación standalone con todas sus características.

 • GUITAR RIG 4 plugins: una versión plugin de GUITAR RIG 4 que podrá integrar a su esta-
ción de audio digital (EAD). En ordenadores con Mac OS X, el programa acepta los forma-
tos VST, AU y RTAS® .

 • Native Instruments Service Center: esta aplicación se encarga de la activación del produc-
to y gestiona las actualizaciones del mismo. Consulte la guía “Setup Guide” para más infor-
mación.

 • Los controladores de la interfaz de audio SESSION I/O.

% 
Si es propietario por primera vez de un producto NATIVE INSTRUMENTS, deberá registrarse 
siguiendo las instrucciones ofrecidas en pantalla. Para más información sobre como crear 

una Cuenta de Usuario NI y sobre la activación de GUITAR RIG 4, consulte la Guía de inicio rápido 
del Centro de Servicio y el manual ubicados en la carpeta de instalación del Centro de Servicio.

Si solamente desea instalar los controladores del aparato, en el CD de instalación hallará por 
separado el correspondiente archivo de instalación del controlador. También podrá descargar 
la última versión del mismo en la sección de asistencia (Support) del sitio de Internet de 
Native Instruments.
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5.2 Instalación del aparato

Utilice el cable USB suministrado para conectar el SESSION I/O directamente en un puerto 
USB 2.0 del ordenador.

El SESSION I/O se alimenta a través de la conexión USB. Su operación sólo puede garanti-
zarse si se lo emplea como dispositivo único de un controlador USB 2.0 o con un hub USB 
2.0 con fuente de alimentación propia.

Tras la correcta instalación del controlador, el SESSION I/O será reconocido automáticamen-
te. Si en algún momento, el ordenador parece no reconocer el SESSION I/O, desconecte el 
cable USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el 
ordenador teniendo la interfaz conectada.
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5.3 Configuración

Este capítulo describe el empleo de la interfaz de audio SESSION I/O en Mac OS X, aten-
diendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a suponer que usted ya ha 
activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte la guía “Setup Guide” 
para más información).

5.3.1 Configurar GUITAR RIG 4
Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL. 
Primero, inicie el programa.

1. Cuando el programa arranque por primera vez, la ventana de configuración de audio 
“Audio Setup” aparecerá automáticamente para que pueda llevar a cabo las configura-
ciones correspondientes. Para abrir esta ventana en un momento posterior, en la barra 
de menú del programa seleccione Guitar Rig 4 > Preferences.

 

2. Abra la ficha „Audio“, y en „Driver“, seleccione CoreAudio como la interfaz del controlador. 

3. Seleccione SESSION I/O en el menú de dispositivos (“Device”).
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Si SESSION I/O no aparece en la lista, entonces algo salió mal. Vuelva a efectuar la instala-
ción de la manera explicada en el apartado 5.1.

La interfaz de audio permite la configuración de los siguientes parámetros:

 • Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa 
de música y con la capacidad de cálculo del ordenador. Por defecto, la frecuencia de mues-
treo está puesta en 44100 Hz (calidad de CD). Frecuencias más altas pueden mejorar la 
calidad del sonido pero exigirán, a su vez, una capacidad de procesamiento mayor.

 • Latency: el deslizante de latencia permite establecer el tamaño del búfer de la interfaz de 
audio (medido en samples). Esto presenta dos efectos: cuanto mayor sea el tamaño del 
búfer, menor será la probabilidad de experimentar problemas en el audio cuando éste sea 
procesado en tiempo real. Por otra parte, el tamaño del búfer afecta directamente la laten-
cia general del sistema. Si incrementa el tamaño del búfer, el tiempo transcurrido entre la 
ejecución de una nota y el momento cuando ésta suena será mayor.

Recomendamos empezar primero con el tamaño de búfer predeterminado y continuar con 
los restantes pasos de la instalación. Cuando haya finalizado, debería cargar un preset limpio 
y simple, y abrir la opción “Audio and MIDI Settings” para buscar la mejor latencia para su 
sistema. Esto se logra moviendo paulatinamente el deslizante de Latency hacia la izquierda 
mientras se está tocando algo. Si empieza a percibir ruidos o fallas, arrastre lentamente el 
deslizante hacia la derecha hasta que los mismos cesen por completo.

5.3.2 Emplear el SESSION I/O como la interfaz de audio predeterminada
Si desea usar el SESSION I/O para reproducir todas las aplicaciones de audio de su ordena-
dor (y no sólo el software de música), deberá configurarlo para que sea la interfaz de audio 
predeterminada del sistema. 

1. Desde el menú de Apple, seleccione Preferencias del sistema:

2. En el panel que se abre, seleccione “Sonido”.
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3. En la ficha de efectos de sonido seleccione la opción SESSION I/O en el menú de 
“Reproducir alertas y efectos de sonido”.

4. Cliquee la ficha de “Salida” y seleccione SESSION I/O en la lista de “Seleccionar un 
dispositivo para la salida de sonidos”.

5. Haga clic en la ficha “Entrada” y seleccione SESSION I/O en la lista de “Seleccionar un 
dispositivo para la entrada de sonidos”.
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5.4 Conexiones de audio y niveles

En los capítulos siguientes aprenderá la manera de conectar el SESSION I/O a su guitarra y 
sistema de altavoces, y a establecer los niveles de amplificación correctos tanto en el aparato 
como en el programa.

Antes de continuar, inicie GUITAR RIG 4.

5.4.1 Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorización para evitar lesiones auditivas.

2. Asegúrese de que el selector de entradas esté puesto en “Instrument” (el botón no está 
oprimido), salvo si quiere emplear un preamplificador para reforzar la señal hasta el nivel 
de línea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del SESSION I/O.

4. Baje el volumen del canal de entrada que no está usando.

Tenga en cuenta que los instrumentos que generan señales estéreo, como por ejemplo los 
sintetizadores de teclado, deberán ser conectados a ambos canales de entrada para obtener 
sonido estereofónico.
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Para obtener la mejor calidad de sonido posible, deberá suministrarle a la interfaz una señal 
que sea lo suficientemente potente; por lo que debería ajustar cuidadosamente el volumen 
de entrada del SESSION I/O.

Los LED de entrada (INPUT) señalan el volumen de la señal entrante en cada canal:

LED de estado Significado

LED apagado La señal no está presente.

LED verde Se está registrando el ingreso de la señal.

LED rojo El volumen de la señal entrante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque 
algunos acordes al volumen al que acostumbra tocar y eche un vistazo al LED del canal em-
pleado:

1. Mientras está tocando, suba la correspondiente perilla de volumen justo hasta que el LED 
de la distorsión empiece a encenderse.

2. Ahora, baje despacio la perilla hasta que el LED de la distorsión no se encienda más, 
aun al tocar acordes muy fuertes.

Ahora la sensibilidad de entrada está puesta en un nivel óptimo y el SESSION I/O puede 
proporcionar un rango dinámico muy alto sin caer en distorsión.

5.4.2 Conectar un segundo instrumento
Es posible conectar un instrumento en cada canal siempre que los mismos suministren el 
mismo tipo de señal (línea o instrumento). Enchufe el cable de un segundo instrumento en 
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Para instrumentos que generan una señal estéreo, es necesario utilizar también el segundo 
canal para lograr así un sonido estereofónico.
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5.4.3 El volumen de entrada de GUITAR RIG 4
Vamos a suponer entonces que su guitarra está conectada a GUITAR RIG SESSION I/O y que 
el volumen de entrada ya fue ajustado adecuadamente (consulte el apartado 5.4.1). Ahora 
debemos asegurarnos de que la señal de entrada sea procesada por el programa con un 
adecuado nivel de volumen.

Eche un vistazo a la cabecera de GUITAR RIG 4: está compuesta por un módulo de entrada 
con selectores de canal (l/r), un supresor de ruido (Gate) sencillo, un módulo de salida con 
un limitador y, finalmente, la información del consumo de CPU.

% 
Para una descripción y explicación detallada del circuito de reducción de ruidos, consulte 
el manual de dicha aplicación.

Tenga en cuenta que el Medidor de entrada mostrará la amplitud al tocar el instrumento. 
También hallará un deslizante de volumen que controla el nivel de entrada del software. 
Ajuste este control hasta conseguir el nivel más alto posible sin producir distorsión. Esto lo 
podrá comprobar con el Medidor de volumen, que se acercará hasta la zona roja sin llegar 
realmente a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibirá una señal mono. Usted 
puede también configurar el módulo de entrada para que direccione la señal de su guitarra a 
través de ambos canales. Por defecto, GUITAR RIG 4 está configurado para procesar ambos 
canales de entrada (l + r están activados), por lo que uno de los canales permanecerá, enton-
ces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el botón 
correspondiente (l o r) a la izquierda del medidor de entrada para desactivar dicho canal y 
que solamente quede activo el canal de entrada en uso. Con esto dirigirá la señal monoaural 
hacia ambos canales.
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5.4.4 Conectar la salida
El SESSION I/O proporciona dos salidas mono (L/R) que le servirán para la conexión de su 
sistema de monitorización, sea éste una mesa de mezclas, un par de altavoces activos o el sis-
tema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, deberá conectar 
los dos altavoces. Un salida estéreo separada (TRS) permite la conexión de sus auriculares.

1. Conecte las salidas del aparato con la entrada de su sistema de amplificación, ponga el 
volumen en su nivel habitual y baje la perilla de volumen de salida.

2. Si está usando auriculares, conéctelos en el enchufe de salida y tenga la precaución de 
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic. Empiece a tocar y vaya 
subiendo cuidadosamente el volumen de salida o de auriculares del SESSION I/O hasta 
alcanzar el nivel deseado.

% Si su instrumento emplea solamente un canal, ponga la perilla de ganancia del otro canal en 
cero.

Ahora todo está listo, ¡ya puede empezar a tocar!
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6 Solución de problemas
Si se encontrara con algún problema en el funcionamiento de su unidad, antes de ponerse en 
contacto con nuestra asistencia técnica, le recomendamos seguir los pasos siguientes para 
encontrar una posible solución.

 • Visite el banco de conocimientos de NI. Puede acceder al mismo rápidamente desde el 
menú de GUITAR RIG 4, seleccione Help > Knowledgebase.

 • Visite el Foro de usuarios de NI (en (http://www.native-instruments.com/forum/) y busque 
respuestas y consejos útiles brindados por la comunidad de usuarios de GUITAR RIG.

Al ponerse en contacto con el equipo de asistencia técnica de Native Instruments, asegúrese 
de tener a mano toda la información relevante. Para saber la versión del controlador y del 
firmware, consulte el panel de control del controlador.

 • En los ordenadores con Windows, este panel se halla en el menú de Inicio, dentro de la 
carpeta de programa GUITAR RIG 4. La información aparecerá después de cliquear en 
“’About”.

 • En ordenadores con Mac OS X, puede acceder al Panel de control del controlador desde 
el sistema de preferencias. La información aparecerá en la ventana principal.

Visite por favor esta dirección URL para ponerse en contacto con nuestro equipo de asistencia 
técnica:

http://www.native-instruments.com/support/

Todos los productos de NATIVE INSTRUMENTS han sido probados reiteradamente en situacio-
nes reales durante su fase de desarrollo. Sin embargo, si el producto necesitara ser devuelto, 
el equipo de soporte técnico le dará un número de RA (Return Authorization) para tramitar el 
procedimiento. Contáctese con nuestro equipo de asistencia técnica antes de efectuar cual-
quier tipo de devolución. Los paquetes que sean devueltos sin este número de RA no podrán 
ser correctamente identificados y no podrían ser procesados de manera eficiente.

http://www.native-instruments.com/forum/
http://www.native-instruments.com/support/
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6.1 Problemas relacionados con el audio

Este apartado brinda información para los problemas de audio más habituales que pudieran 
suceder.

6.1.1 No hay sonido o suena poco volumen
Hay varias razones posibles por la cuales no se produce sonido o el mismo sale con poco 
volumen:

 • Cables rotos o desconectados. Revise todos los cables y conexiones.

 • Se ha seleccionado una tarjeta de sonido o una entrada de audio incorrecta. Verifique que 
el controlador del SESSION I/O esté seleccionado en la opción Audio and MIDI Settings del 
menú de GUITAR RIG 4 

 • Se ha seleccionado el canal equivocado en el módulo de entrada de GUITAR RIG 4. Conecte 
su instrumento en la otra entrada o seleccione “L” para cambiar de canal.

 • La ganancia de entrada del SESSION I/O está puesta muy baja. Suba la perilla hasta el 
nivel deseado.

 • La perilla de volumen de su instrumento está bajada. Suba la perilla de volumen.

6.1.2 Señal distorsionada
Si la señal de audio suena distorsionada y, sin embargo, GUITAR RIG 4 no está añadiendo 
ningún tipo de distorsión, lo más probable es que la ganancia del SESSION I/O esté muy alta. 
Reduzca el nivel de entrada de la interfaz para evitar que el preamplificador cause distorsión. 
Si su instrumento produce una señal tan alta como para que el preamplificador esté siempre 
saturado, reduzca entonces su volumen. Normalmente, esto sólo sucede cuando el instrumento 
viene equipado con una electrónica especial, como por ejemplo pastillas de alta salida.
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6.1.3 Ruido
Cuando se percibe zumbido, las razones que lo causan pueden ser variadas:

 • Las pastillas de bobinado simple son propensas a recoger las interferencias eléctricas. Las 
pastillas Humbucker producen mucho menos ruido.

 • Su guitarra está muy cerca del equipo eléctrico. Para reducir este tipo de zumbido, despla-
ce la guitarra más lejos del equipo.

 • La perilla de volumen de la guitarra está puesta muy bajo. Suba la perilla. Si la guitarra 
cuenta con más de una perilla de volumen, verifique el volumen de todas la perillas.

 • Está empleando un cable roto o que no está debidamente protegido. La pantalla de la gui-
tarra podría no ser suficiente. Primero trate de reemplazar el cable por un modelo con 
pantalla protectora. Si esto no funciona, un profesional debería revisar la electrónica de su 
guitarra y dotarla de una protección mejor.

Si percibe siseo, el volumen de entrada del SESSION I/O puede estar demasiado bajo. Suba 
el volumen del instrumento o incremente el nivel de entrada del SESSION I/O. Para más 
información sobre el ajuste del nivel de entrada, consulte la sección 4.4 (Windows XP/Vista) 
o la sección 5.4 (Mac OS X) de este manual.

6.1.4 Bucles de masa
Los bucles de masa (generalmente percibidos como un zumbido de baja intensidad) son un 
problema frecuente que se produce cuando varios dispositivos eléctricos forma parte del 
mismo circuito eléctrico. Los siguientes pasos lo ayudarán a eliminarlos:

 • Desconecte todos los dispositivos que no esté usando, p. ej., dispositivos periféricos conec-
tados al ordenador (discos externos, grabadoras de CD, etc.).

 • Conecte una caja DI detrás de las salidas del SESSION I/O . La mayoría de estas cajas tie-
nen un interruptor que se usa para romper el bucle y eliminar de esta forma el ruido.
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6.2 Problemas relacionados con el hardware

Verifique la disponibilidad de actualizaciones y otras informaciones relativas a SESSION I/O 
en el sitio de Internet de Native Instruments y en el NI Service Center.

6.2.1 Problemas relativos al controlador
Asegúrese de que SESSION I/O esté conectado al ordenador y abra el panel de control del 
controlador. La ubicación del mismo ya la hemos señalado en la introducción de este capítulo 

Si el panel de control no se encontrara, es probable que el controlador no se haya podido 
instalar. En este caso, vuelva a instalar el controlador de la manera descrita más arriba en 
este manual.

Si todos los menús desplegables del panel de control aparecen de color gris, significa que el 
SESSION I/O no ha sido reconocido por el controlador. Es posible que algo no ande bien con 
la conexión USB, la sección siguiente le brindará más detalles al respecto.

6.2.2 Problemas relativos a la conexión USB
SESSION I/O es una interfaz USB 2.0 y no funciona en puertos USB 1.0 o 1.1 . Lo mejor 
es conectar el aparato directamente en un puerto USB 2.0 del ordenador. Además, el puer-
to necesita cumplir los requisitos mínimos de alimentación eléctrica de un puerto USB 2.0 
(500 mA). Algunos ordenadores no satisfacen el estándar oficial de alimentación eléctrica 
para puertos USB 2.0 . En este caso, es posible que un mensaje aparezca indicando que 
no hay suficiente energía disponible para operar el dispositivo. SESSION I/O podría entonces 
producir crepitaciones o directamente no funcionar.

 • Si su ordenador no puede suministrar suficiente energía, haga la prueba de conectar su 
SESSION I/O en un hub USB 2.0 con fuente de alimentación propia. En este caso, debería 
evitar la conexión de otros dispositivos al hub, dado que éstos disminuirían la potencia total 
disponible.

 • En caso de fallas, resulta útil comprobar si SESSION I/O funciona mejor al desconectar los 
otros dispositivos USB del ordenador.
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 • Si experimenta fallas en el audio o algún otro tipo de problema relacionado con la co-
nexión USB, conecte el SESSION I/O en otro puerto USB 2.0 del ordenador.

 • Un cable USB en mal estado puede ser responsable de las caídas en el audio y de otros 
problemas de conectividad. Pruebe con un cable diferente (con el logo oficial USB); en 
algunos casos también resulta beneficioso emplear un cable más corto.

 • Si SESSION I/O experimenta problemas de mal desempeño en una máquina Windows, lo 
primero que debería hacer es deshabilitar el control de alimentación de los hub USB, que 
siempre se encuentra activado por defecto. Vaya al administrador de dispositivos (Panel de 
control > Sistema > Hardware) y haga clic con el botón secundario en un hub USB para 
abrir sus propiedades. En la página de control de alimentación desmarque todas las casillas. 
Repita esto para cada hub y luego reinicie el sistema.

6.2.3 Emplear el SESSION I/O con un ordenador portátil
Primero debería verificar que el ordenador sea apto para manejar el procesamiento de audio 
en tiempo real sin experimentar fallas. En la red encontrará un par de herramientas gratuitas 
que le servirán para analizar la capacidad de su sistema, por ejemplo:

www.thesycon.de/deu/latency_check.shtml

Inicie esta herramienta con el SESSION I/O desconectado. En caso de que su ordenador no 
pueda procesar audio sin experimentar problemas, la herramienta le mostrará barras rojas 
de latencia y reportará esto en la caja situada abajo de todo.

En general no se recomienda el empleo de ordenadores portátiles con tarjetas de memoria 
gráfica compartida. Seguramente va a necesitar toda la memoria y capacidad de procesa-
miento disponibles para sus proyectos de audio.

http://www.thesycon.de/deu/latency_check.shtml
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Aquí le presentamos algunos consejos para optimizar el desempeño de su portátil:

 • No se recomienda usar el ordenador con las baterías porque el administrador de energía 
podría hacer atrasar el reloj del CPU para ahorrar consumo.

 • Desconecte todo los aparatos que no vaya a usar (p. ej., impresoras y escáneres). Esto ali-
viará el trabajo del ordenador y aumentará la capacidad de procesamiento disponible para 
el programa musical.

 • Los ordenadores portátiles están equipados con dispositivos integrados que pueden per-
turbar el procesamiento de audio, entre los más comunes se cuentan los adaptadores de 
red y la tarjetas inalámbricas LAN. Es posible que tenga que desconectar estos dispositivos 
cuando quiera trabajar con SESSION I/O.
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7 Especificaciones técnicas
Esta sección presenta las especificaciones técnicas relevantes del hardware del SESSION I/O .

7.1 Enchufes:

 • 2 enchufes hembra de entrada (In 1, In 2) para conectores mono de ¼” (6,3 mm).

 • 2 enchufes hembra de salida (Out 1, Out 2) para conectores mono de ¼” (6,3 mm) (no 
balanceados) o conectores TRS (tip/ring/sleeve balanceados).

 • 1 enchufe de auriculares para conector de ¼” (6,3 mm).

 • 1 USB 2.0 Tipo B
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7.2 Especificaciones de audio

Entradas de audio (A/D)

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Definición en bits 16 y 24 bits

Convertidor Cirrus Logic

Entrada de micrófono

Impedancia de entrada 4,8 kΩ (balanceado)

Nivel máximo con ganancia máxima -46 dBu

Nivel máximo de entrada 0 dBu

THD+N 0,008%

Respuesta de frecuencia 10 - 40000 Hz (-1 dB)
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Entrada de línea

Impedancia de entrada 44 kΩ no balanceado & balanceado

Nivel máximo con ganancia máxima -2,19 dBu

Nivel máximo de entrada +15 dB no balanceado & balanceado

SNR (ponderado) 96,2 dB

THD+N 0,008%

Respuesta de frecuencia 10 - 40000 Hz (-1 dB)

Entradas de instrumento

Impedancia de entrada 1 MΩ no balanceado

Nivel máximo con ganancia máxima -8.3 dBu

Nivel máximo de entrada +9 dB no balanceado

SNR (ponderado) 95,9 dB

THD+N 0,008%

Respuesta de frecuencia 10 - 40000 Hz (-1 dB)
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Salidas de audio (D/A)

Canales 2

Frecuencia de muestreo 44,1; 48; 88,2; 96 y 192 kHz

Definición en bits 16 y 24 bits

Convertidor Cirrus Logic

Salidas de línea

Impedancia de salida 100 Ohms no balanceado, 200 Ohms balanceado

Nivel máximo de salida +6 dBu

SNR (ponderado) 100 dBu

THD+N 0,008%

Respuesta de frecuencia 10 - 45000 Hz (-0.5 dB)
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Salida de auriculares

Impedancia de carga 8-600 Ohmios

Nivel máximo de salida 1.67 V eff @ 100 Ohms

SNR (ponderado) 98,2 dB

THD+N (60 Ohms) 0,008%

Respuesta de frecuencia 10 - 40000 Hz (-1 dB)

7.3 Suministro de energía

Vía interfaz USB 2.0, puerto de alimentación de 5 V / 500 mA 

No se necesita ninguna otra fuente de energía o batería, solamente es requerida la energía 
del USB. Sin embargo, sólo se garantiza un funcionamiento adecuado cuando SESSION I/O 
se emplea como el único dispositivo conectado a un controlador USB 2.0 o a un hub USB 
2.0 autopotenciado.

7.4 Dimensiones y peso

121 x 115 x 40 mm (4,76 x 4,53 x 1,57 pulgadas)

0,56 kg (1,235 lb)
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7.5 Especificaciones ambientales

Temperatura de funcionamiento: de 0°C a 40°C (32°F s 104°F), (85% de humedad no con-
densada) 

Temperatura de almacenamiento: entre -20°C y 50°C (-4°F a 122°F), (85% de humedad no 
condensada)

7.6 Requisitos de sistema

7.6.1 Especificaciones generales del sistema
 • Intel® Pentium™ o AMD® Athlon™ XP a 1,4 GHz, Windows XP Service Pack 2 o Windows 

Vista™ (32/64 bit) y 1024 MB de RAM, USB 2.0

 • Mac OS 10.5, Intel® Core™ Duo 1.66 GHz, 1024 MB RAM, USB 2.0

7.6.2 Formatos de controlador soportados
 • Mac OS® X: Core Audio™

 • Windows: ASIO® (recomendado), DirectSound™, WASAPI™

7.6.3 Plataformas aceptadas
 • Mac OS® X: Standalone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)

 • Windows®: standalone, VST® y RTAS® (Pro Tools 7/8)


	1	¡Bienvenido a GUITAR RIG SESSION!
	2	Antes de empezar: Observaciones importantes
	2.1	Números de serie y chapa identificadora
	2.2	Usar la unidad de manera segura
	2.2.1	Advertencia
	2.2.2	Precauciones
	2.2.3	Deposición del producto

	2.3	Descargo de responsabilidad

	3	El hardware del SESSION I/O
	3.1	Panel frontal
	3.2	Panel superior
	3.3	Panel posterior

	4	Instalación en Windows XP / Windows Vista
	4.1	Instalación del programa 
	4.2	Instalación del aparato
	4.3	Configuración
	4.3.1	Configurar GUITAR RIG 4
	4.3.2	Emplear el SESSION I/O como la interfaz de audio predeterminada

	4.4	Conexiones de audio y niveles
	4.4.1	Conectar el instrumento y ajustar el volumen de entrada
	4.4.2	Conectar un segundo instrumento
	4.4.3	El volumen de entrada de GUITAR RIG 4
	4.4.4	Conectar la salida


	5	Instalación en Mac OS X
	5.1	Instalación del programa 
	5.2	Instalación del aparato
	5.3	Configuración
	5.3.1	Configurar GUITAR RIG 4
	5.3.2	Emplear el SESSION I/O como la interfaz de audio predeterminada

	5.4	Conexiones de audio y niveles
	5.4.1	Conectar el instrumento y ajustar el volumen de entrada
	5.4.2	Conectar un segundo instrumento
	5.4.3	El volumen de entrada de GUITAR RIG 4
	5.4.4	Conectar la salida


	6	Solución de problemas
	6.1	Problemas relacionados con el audio
	6.1.1	No hay sonido o suena poco volumen
	6.1.2	Señal distorsionada
	6.1.3	Ruido
	6.1.4	Bucles de masa

	6.2	Problemas relacionados con el hardware
	6.2.1	Problemas relativos al controlador
	6.2.2	Problemas relativos a la conexión USB
	6.2.3	Emplear el SESSION I/O con un ordenador portátil


	7	Especificaciones técnicas
	7.1	Enchufes:
	7.2	Especificaciones de audio
	7.3	Suministro de energía
	7.4	Dimensiones y peso
	7.5	Especificaciones ambientales
	7.6	Requisitos de sistema
	7.6.1	Especificaciones generales del sistema
	7.6.2	Formatos de controlador soportados
	7.6.3	Plataformas aceptadas



